
e2 studio 3.1.1.8 
e2 studio 3.1.1 release documentation 

 

This document outlines the device support, new features added in 3.1, fixed issues 
and open issues in e2 studio 3.1.1.   

 

1. Project Generator Support 
 

CPU Family Devices 

RH850 

F1H R7F701503, R7F701513 (Debug Support Only) 

F1L 

R7F701002xAFP,  R7F701003xAFP,  R7F701006xAFP, R7F701007xAFP, R7F701008xAFP, 
R7F701009xAFP, R7F701010xAFP, R7F701011xAFP, R7F701012xAFP, R7F701013xAFP, 
R7F701014xAFP, R7F701015xAFP, R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, 
R7F701019xAFP, R7F701020xAFP, R7F701021xAFP, R7F701022xAFP, R7F701023xAFP, 
R7F701024xAFP, R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, R7F701028xAFP, 
R7F701029xAFP, R7F701030xAFP, R7F701031xAFP, R7F701032xAFP, R7F701033xAFP, 
R7F701034xAFP, R7F701035xAFP, R7F701040, R7F701041, R7F701042, R7F701043, 
R7F701044, R7F701045, R7F701046, R7F701047, R7F701048, R7F701049, R7F701050, 
R7F701051, R7F701052, R7F701053, R7F701054, R7F701055, R7F701056, R7F701057 

(Debug Support Only) 

R1L R7F701062xAFP, R7F701067xAFP, R7F701071xAFP (Debug Support Only) 

RL78 
D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME, R5F10DGC, 
R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, 
R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ,  R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, R5F109AA, R5F109AB, 
R5F109AC, R5F109AD, R5F109AE, R5F109BA, R5F109BB, R5F109BC, R5F109BD, R5F109BE, 
R5F109GA, R5F109GB, R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 
R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, R5F10AAD, R5F10AAE, 
R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, 
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, 
R5F10AME, R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, R5F10BGC, 
R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, 
R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, R5F10PGF, 
R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, 
R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, 
R5F10PPG, R5F10PPH, R5F10PPJ 

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, R5F10278, R5F10279, 
R5F1027A, R5F102A7, R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367, R5F10368, 
R5F10369, R5F1036A, R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA 

G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, R5F1007D, R5F1007E, 
R5F1008A, R5F1008C, R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD, R5F100AE, 
R5F100AF, R5F100AG, R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, R5F100EA, R5F100EC, 
R5F100ED, R5F100EE, R5F100EF, R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD, 
R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ, R5F100GK, 
R5F100GL, R5F100JC, R5F100JD, R5F100JE, R5F100JF, R5F100JG, R5F100JH, R5F100JJ, 
R5F100JK, R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 
R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK, 
R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ, R5F100PK, R5F100PL, R5F100SH, 
R5F100SJ, R5F100SK, R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, R5F1018E, R5F101AA, 
R5F101AC, R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA, R5F101BC, R5F101BD, 
R5F101BE, R5F101BF, R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, R5F101EG, R5F101EH, 
R5F101FA, R5F101FC, R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, R5F101FJ, 
R5F101FK, R5F101FL, R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 
R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, R5F101JE, R5F101JF, 
R5F101JG, R5F101JH, R5F101JJ, R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE, 
R5F101LF, R5F101LG, R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 
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R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH, R5F101PJ, 
R5F101PK, R5F101PL, R5F101SH, R5F101SJ, R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, R5F104BA, R5F104BC, 
R5F104BD, R5F104BE, R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD, R5F104CE, 
R5F104CF, R5F104CG, R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, R5F104FG, R5F104FH, 
R5F104FJ, R5F104GA, R5F104GC, R5F104GD, R5F104GE, R5F104GF, R5F104GG, R5F104GH, 
R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 
R5F104JH, R5F104JJ, R5F104JK, R5F104JL, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, R5F104MG, R5F104MH, 
R5F104MJ, R5F104MK, R5F104ML, R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK, 
R5F104PL 

G1A R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, R5F10EBD, R5F10EBE, 
R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 

I1D R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, R5F117AC, R5F117BA, 
R5F117BC, R5F117GA, R5F117GC 

L12 
R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, R5F10RG8, R5F10RGA, 
R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC  

L13 R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, R5F10WMA, 
R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, R5F10WMG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110PE, R5F110PF, R5F110PG, 
R5F110PH, R5F110PJ, R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111MJ, R5F111PE, 
R5F111PF, R5F111PG, R5F111PH, R5F111PJ, R5F110NE, R5F110NF, R5F110NG, R5F110NH, 
R5F110NJ, R5F111NE, R5F111NF, R5F111NG, R5F111NH, R5F111NJ 

RX 110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F5111J, R5F51116, R5F51117, R5F51118 

210 R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, R5F5210A, R5F5210B 

21A R5F521A6, R5F521A7, R5F521A8 

220 R5F52201, R5F52203, R5F52205, R5F52206 

610 R5F56104, R5F56106, R5F56107, R5F56108 

621 R5F56216, R5F56217, R5F56218 

62G R5F562G7, R5F562GA 

62N R5F562N7, R5F562N8 

62T R5F562T6, R5F562T7, R5F562TA 

630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E 

631 

R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B, R5F5631D, R5F5631E, R5F5631F, 
R5F5631G, R5F5631J, R5F5631K, R5F5631M, R5F5631N, R5F5631P, R5F5631W, R5F5631Y, 
R5S56310 

 

R5F5631MF, R5F5631PF (Debug Support Only) 

63N R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, R5F563NK, R5F563NW, R5F563NY 

63T 

R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TC, R5F563TE, R5F563TE_5V 

 

R5F563TB_5V, R5F563TC_5V (Debug Support Only) 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

RZ A1 R7S72100, R7S72101, R7S72102 
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SH 

SH2 SH7047F, SH70834A, SH70844A, SH70854A, SH70865A, SH71242, SH71252, SH7144F, 
SH7145F, SH71464A, SH71491R, SH7615, SH7616, SH7618, SH7619 

SH2A 
SH7201, SH7203, SH72165AD, SH72546RFCC, SH72611, SH72620, SH72630, SH72640, 
SH72690, SH7670 

SH2a (No FPU) SH7206, SH7211, SH7243, SH7285, SH7286 

Other 

SH70835A, SH70835R, SH70845A, SH70845R, SH70855A, SH70855R, SH70865R, SH71243, 
SH71253, SH71464R, SH71494A, SH71494R, SH7214, SH72145AD, SH72145BD, SH72146AD, 
SH72146BD, SH72147AD, SH72147BD, SH7215, SH72165BD, SH72166AD, SH72166BD, 
SH72167AD, SH72167AD_Option, SH72167BD, SH72265, SH72266, SH72267, SH72275, 
SH72276, SH72277, SH72314L, SH72315A, SH72315L, SH72374A, SH72374B, SH72375B, 
SH72394A, SH72394B, SH72395A, SH72395B, SH72531, SH72531FCC, SH72531RFCC, 
SH72533, SH72533FCC, SH72543R, SH72544R, SH72546R, SH72612, SH7261_FPULess, 
SH72621, SH72622, SH72623, SH72624, SH72625, SH72626, SH72627, SH72631, SH72632, 
SH72633, SH72641, SH72642, SH72643, SH72644, SH72645, SH72646, SH72647, SH72660, 
SH72661, SH72662, SH72663, SH72670, SH72671, SH72672, SH72673, SH72680, SH72681, 
SH72691, SH7606, SH7618A, SH7671, SH7672, SH7673 (Debug Support Only) 
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2. Code Generator Support 
 

CPU Family Devices 

RL78 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, R5F109AA, R5F109AB, 
R5F109AC, R5F109AD, R5F109AE, R5F109BA, R5F109BB, R5F109BC, R5F109BD, R5F109BE, 
R5F109GA, R5F109GB, R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 
R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, R5F10AAD, R5F10AAE, 
R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, 
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, 
R5F10AME, R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, R5F10BGC, 
R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, 
R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG, 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, R5F10PGF, 
R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, 
R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, 
R5F10PPG, R5F10PPH, R5F10PPJ, 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, R5F10278, R5F10279, 
R5F1027A, R5F102A7, R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367, R5F10368, 
R5F10369, R5F1036A, R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA, 

G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, R5F1007D, R5F1007E, 
R5F1008A, R5F1008C, R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD, R5F100AE, 
R5F100AF, R5F100AG, R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, R5F100EA, R5F100EC, 
R5F100ED, R5F100EE, R5F100EF, R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD, 
R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ, R5F100GK, 
R5F100GL, R5F100JC, R5F100JD, R5F100JE, R5F100JF, R5F100JG, R5F100JH, R5F100JJ, 
R5F100JK, R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 
R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK, 
R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ, R5F100PK, R5F100PL, R5F100SH, 
R5F100SJ, R5F100SK, R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, R5F1018E, R5F101AA, 
R5F101AC, R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA, R5F101BC, R5F101BD, 
R5F101BE, R5F101BF, R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, R5F101EG, R5F101EH, 
R5F101FA, R5F101FC, R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, R5F101FJ, 
R5F101FK, R5F101FL, R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 
R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, R5F101JE, R5F101JF, 
R5F101JG, R5F101JH, R5F101JJ, R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE, 
R5F101LF, R5F101LG, R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 
R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH, R5F101PJ, 
R5F101PK, R5F101PL, R5F101SH, R5F101SJ, R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, R5F104BA, R5F104BC, 
R5F104BD, R5F104BE, R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD, R5F104CE, 
R5F104CF, R5F104CG, R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, R5F104FG, R5F104FH, 
R5F104FJ, R5F104GA, R5F104GC, R5F104GD, R5F104GE, R5F104GF, R5F104GG, R5F104GH, 
R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 
R5F104JH, R5F104JJ, R5F104JK, R5F104JL, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 
R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, R5F104MG, R5F104MH, 
R5F104MJ, R5F104MK, R5F104ML, R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK, 
R5F104PL 

G1A R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, R5F10EBD, R5F10EBE, 
R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE, 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
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I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1D R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, R5F117AC, R5F117BA, 
R5F117BC, R5F117GA, R5F117GC 

L12 R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, R5F10RG8, R5F10RGA, 
R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC  

L13 R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, R5F10WMA, 
R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, R5F10WMG 

L1C 
R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110PE, R5F110PF, R5F110PG, 
R5F110PH, R5F110PJ, R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111MJ, R5F111PE, 
R5F111PF, R5F111PG, R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F5111J 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 
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3. What is new in 3.1? 
 

Component Description 
Multicore 
Debugger 

e2 studio 3.1 contains support for the RH850 F1H device.  This is a multicore device 
and support has been added to support multicore debugger features in 3.1. 
 

RH850 
Debugging 

The RH850 debugger now includes performance analysis support. 

Application Some customers noticed that the .cproject file could be changed when the project is 
saved even though no changes were made by the user. 
 
This has been improved in e2 studio 3.1. 
 

CDT CDT has been updated to version 8.4.  A list of newly added features can be found 
here on the CDT wiki site: 
 
https://wiki.eclipse.org/CDT/User/NewIn84 
 
 

Trace view The trace view has been revised in e2 studio 3.1 to improve reliability and 
robustness.  All areas of the view have been improved in particular scrolling speed 
and response and saving and loading large amounts of trace data. 
 

Waveform The waveform view has been enhanced to support 24bit (32bit) stereo/mono. 
 

Stack Analysis The following features have been improved in the Stack Analysis view: 
 

• Find now allows search conditions to be specified.  Such as symbol, code 
size or data size. 

• A sort feature has been added to the function details table. 
• A feature to show the ascending order of stack size has been added to the 

function tree display. 
• Improved progress controls have been implemented when the system is busy 

to better inform the user the status of what is happening. 
  

RZ Debugger The RZ debugger has been improved to add hardware eventpoint support. 
 

Renesas RTOS 
plugin 

Plugins have been added to support the RI600V4 Renesas RTOS.  Views have been 
added that can show RTOS resource usage and task analysis. 
 
In addition special support has been added to the project generator to assist the user 
to generate and build RI600V4 RTOS projects. 
 

Project Import A new feature has been added that allows users to import and change the name of 
the project in one operation.  This makes it much easier to copy and clone a project 
to another name.  This is available from the File->Import menu item. 
 

Language support Chinese language support has been added for the menus. 
 

ARM DS-5 
Project Import 

e2 studio 3.1 implements a project import facility from the KPIT RZ GCC DS-5 
projects into the equivalent support in e2 studio.  This feature will be made available 
via the standard Eclipse import function.  This import facility also changes the RZ 
toolchain projects to the generic naming of the ARM GCC toolchain. 

Note the ARM toolchain DS-5 projects will not be supported by this import function. 
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Partner OS plugin A new view named the Partner OS view has been provided in e2 studio 3.1.  This 
view provides simple RTOS support for 3rd party RTOS vendors.  In 3.1 there is 
support for Micrium and Segger included. 
 

HEW Import The HEW import facility has been enhanced to include a “Emulate HEW link order” 
feature.  This allows the user to select whether e2 studio should change its standard 
link order to emulate that used in HEW.  Some customers have experienced project 
build issues due to the difference in link order between HEW and e2 studio. 
 

IO Registers The IO register window is now linked to the smart manual so that information on 
registers can be displayed when hovering over IO registers in the view. 
 

Optimization 
Assistant 

The Optimization Assistant is a new plugin provided within e2 studio to guide the user 
which build options are best for their project. 
 
The Optimization Assistant plug-in provides recommended build option sets for each 
optimization level.  The Optimization Assistant plug-in builds the selected 
configurations, and this plug-in acquires information about the build such as ROM 
size, function size and so on. 

 This plug-in then displays the following information in the view: 

1. Displays a total value of the ROM size for each configuration graphically.  
2. Displays the size of each function or file by a table.  
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4. Useful workarounds and information for 3.1 
 

ID Component Workaround or information 
NA Application If you are experiencing slow building of projects within e2 studio there are some 

possibilities to improve. 
 
The system environment will attempt to find the make.exe tool via the system 
environment.  If you ensure the directory make resides in is at the start of the 
path variable it will find it more quickly.  Especially important if there are 
network drives in the path. 
 
In the project properties, C/C++ Build tab, behavior tab you can switch on 
parallel build.  This will take advantage of the multi-cores on your host machine 
if it has them.  In e2 studio 2.1 or later this now defaults to on for new projects. 
 

NA RZ Support There are some limitations with the current RZ integration in e2 studio: 
 

1. The iodefine.h file is not generated as part of the project generation 
process.  This file is available from the Renesas website along with 
sample code to help your development. 

2. The IO Registers window does not show the IO registers for the RZ/A1. 
3. When using real-time features for the RZ/A1 the debugger will be 

suspended when any real-time memory operation takes place.  This 
includes expressions, memory and Visual expressions. 

4. The RZ/A1 does not support the trace window in 3.1. 
 
 

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was support at version 14.01.  This version 
is no longer supported within e2 studio. 
 
KPIT have modified the name of their ARM toolchain to be ARM-none-eabi to 
follow standard ARM naming convention like other GCC toolchain vendors. 
 
The toolchain is available at version 14.01 and 14.02 from the KPIT website.  
The binaries in the 14.01 version is identical to that used in the 14.01 RZ 
toolchain. 
 
Once the toolchain is installed your projects will be imported and ported to 
ensure there is as little disruption as possible due to this change. 
 

NA GCC Build 
Plugin 

The GNU toolchain linker file format has changed in 3.0.  This means projects 
that are developed in 3.0 and opened in 2.x will still continue to build.  However 
you may experience issues visiting the GCC Linker Sections user interface. 
 

5041 Code 
Generator 

Code Generator can delete user code between /* Start */ End comments in 
some situations. 
Using the code generator if the following code is placed in the main function:  
//if(data_in!=0xAA){  
On a line by itself, all of the main code will be removed when Generate Code 
button is pressed. 
The key issue is that the {brace is on the same line as the comment. 
 

2010 HEW Importer Symptoms: Project fails to build after import from HEW 
 
Conditions: If a long filename or path is used, and the HEW project importer is 
used, the project may fail to build. 
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Workaround: Move the original HEW project to a shallow directory structure 
(i.e.) C:\Workspace and import from there.  Also ensure that the HEW project is 
relocated before importing into e2 studio. 

2421 Debug 
Configurations 

Debug configurations have been modified since e2 studio 2.x.  So although you 
can re-use the workspace and projects from e2 studio 1.x when you open the 
debug launch configuration for the first time it is updated. 
 
Before doing this you should back-up the .launch file if you need to keep a 1.x 
version. 
 

NA Application It is not possible to import e2 studio 1.x projects which are for the V850 device 
into e2 studio 2.0. 
 

1922 Application Symptoms: Project fails to build in first instance after archive project import (not 
from HEW) 
 
Conditions: If an archived project is imported it may fail to build the first time, 
due to a residual .d file. 
 
Workaround: Clean and Build a second time. 
 

2761 CODAN When using assembly code within a C source file, Codan errors can be 
observed in the editor. Even though the project builds successfully. 
 
We do not have a workaround for this at this time. 
 

2728 GDB Step into does not always work when using the CCRX 1.02.01 toolchain. 
 
To ensure this behaves correctly you will need to use CCRX 2.00.00 or greater 
as this issue with the debug information is corrected in this release. 
 

NA Eventpoints If eventpoints do not always work just after they are set, you can use the "Apply 
to Target" toolbar button in the Eventpoint view to send the Eventpoints to the 
target manually.  This will always ensure the debugger target has all the 
required eventpoint updates before execution starts. 
 

5772 IAR Plugins The IAR Plugin Manager is now included in e2 studio.  This provides support for 
RX, RL78, RH850 and RZ (ARM). 
 
This is a tool which simplifies installation and configuration of IAR toolchain 
plugins. You can access this though Help -> IAR Embedded Workbench plugin 
manager. 
 
In some cases you may need to remove existing IAR RX & RL78 plugins to 
install other newly supported device plugins (e.g. RH850). 

5903 Code 
Generator 

For the following RL78 code generator project, "Peripheral Functions" view tabs 
may not be operated with double-clicking "Peripheral Functions" branch of 
Project Explorer view. 
 
After creating/loading the project, please show "Code Preview" view by double-
clicking of "Code preview" branch at Project Explorer tree at first. Then, please 
access Code Generator setting tabs by double-clicking Project Explorer tree or 
using pull-down menu by pressing triangle button at the up-right corner of 
Peripheral Functions view. 
 
RL78/G12, RL78/G13, RL78/G14, RL78/G1A, RL78/I1A, RL78/F13, RL78/F14, 
RL78/F12, RL78/L12 
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5. Fixed issues in 3.1.1.8 
 

ID Component Description 

5891 RL78 GDB Server 

When using an IAR project the download can fail due to the 
project being setup to write to the vector table area.  This 
check has been removed in 3.1.1.8 so download now 
succeeds. 
 

 

6. Fixed issues in 3.1.1.7 
 

ID Component Description 

3490 Real-time Watch 

If a data type of a variable already displayed in the 
expressions view is updated, e.g. from char to long, after a 
re-build the expression view data type is not updated. 
However the data value is correct. 
 
Closing the debugger or e2studio does not clear the issue 
but clean does. 

5628 Application 
When debugging RZ devices the IO Register window 
remains empty.  It should show the IO registers for these 
devices. 

5659 Profile plugin The workaround for Profile not working on subsequent 
debug sessions is to restart e2Studio. 

5731 GDB Server RZ 
When viewing IO registers for the RZ debugger the values 
are not shown correctly in the memory view or IO Registers 
view. 

5751 Project Generation New projects that are created for the RZ device family do 
not include an iodefine.h file. 

5752 Application 

When updating dependencies in a build for the ARM GCC 
toolchain the following error can be displayed.  This error 
occurs when assembly source files are present in the ARM 
GCC project. 
 
 
 
"*.d: *** Missing separator. Stop." 
 
 
 
The only workaround is to delete the .d file mentioned in the 
error. 

5754 Application RZ projects from previous e2 studio products that use the 
KPIT RZ GCC toolchain are not importing to the new KPIT 
ARM-none toolchain correctly.  The paths are not corrected. 

5772 IAR Plugins 

 
The IAR Plugin Manager is now included in e2 studio.  This 
provides support for RX, RL78, RH850 and RZ (ARM). 
 
This is a tool which simplifies installation and configuration 
of IAR toolchain plugins. You can access this though Help -
> IAR Embedded Workbench plugin manager. 
 
In some cases you may need to remove existing IAR RX & 
RL78 plugins to install other newly supported device plugins 
(e.g. RH850). 

5841 Application 

 
On Japanese Windows a problem was noted for GCC 
projects.  When a user is using a non-default value for the 
“Command file override” option in the linker settings it can 
cause the build to fail. 
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This is often more noticeable when using additional settings 
in the C run-time library from defaults also. 
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7. Fixed issues in 3.1 
 

ID Component Description 

301 Trace plugin Trace buffer full functionality needs addition.  New checkbox needs adding to the 
GUI. 

475 GDB server RL78 Once a debug session has been terminated when using an IECUBE another 
connection is not possible until the IECUBE had been unplugged from the 
machine. 

785 Trace plugin Bus mode records sometimes fail to update if rapid cycling through the available 
trace modes. 

2735 Trace plugin When using an IECUBE emulator saving large trace buffers can fail to complete. 

3160 Application 

The address of pointer type variable cannot be modified in Expressions View. e.g. 
 
typedef int* PI; 
 
PI s_pi = &glb; 
 
In this case, address value of s_pi cannot be modified in Expressions View. 

3625 Application When using the Snapshot trace feature the data mask settings are not applied 
correctly. 

3798 Trace plugin 

Creating a new trace file for E20 trace data takes a long time to complete due 
obtaining disassembly data for all the available records. 
 

During this period of obtaining disassembly data the debugger controls can 
become unresponsive. 

3867 Application When the current configuration is set to a custom configuration created by the 
user.  The configuration following an export and import into another workspace is 
not restored correctly.  It is restored to HardwareDebug. 

3932 Application If e2 studio is installed into the desktop folder or the workspace is within the "My 
documents" area on Japanese operating systems, the object converter can fail to 
execute correctly. 

4176 CCRX Build plugin 

The Renesas CCRX toolchain fails to build projects with the following conditions:  
 
a. Project name with Chinese characters  
 
b. Project located in a path with Chinese character  
 
c. Project contains file with Chinese character 

4280 Integration Server 
The GetExpressionS function in the Integration Server will in some cases return an 
invalid string. Workaround is to use the ReadMemory call to get the raw data. 
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4312 Application 

The current e2 studio build restricts the file types that can be used as input files. 
 
 
For example assembler input files only supports the following: 
 
.src 
.SRC 
.Src 

4397 Application If the .*linker files in a project are read-only and the linker map is modified then no 
error is displayed or logged. But the changes are not saved. 

4445 Application 

For GCC RL78 there is an option Select Additional CPU Options" in the project 
generator with the following options: 
 
 : None 
 
 : Use Emulation for multiplication 
 
 : Use RL78 native multiply for G14 
 
 : Use RL78 hardware multiply for G13 
 
 
However, there are more device families which support the native or hardware 
multiply: 
 
RL78 native multiply: F13, F14, G14 
 
RL78 hardware multiply: D1A, F12, G12, G13, G1E, I1A, L12, L13 
 
Emulation for multiplication ONLY: G10 
 
The user interface should be updated to better reflect the situation for the RL78 
devices. 

4538 Static Analysis plugin The static analysis plugin cannot jump to the source location of a specified static 
function. 

4548 Application 

When debugging with RX there are problems with setting breakpoints when the 
hardware breakpoint resources have been exhausted and the software breakpoint 
setting also fails. 
 
In this case the breakpoint appears to be valid but the debugger will not stop. 
 
This can often be seen when the option "Program re-writes internal Program ROM" 
is set to yes.  As this means software breakpoints cannot be set. 

4550 Application 

There is a problem in e2 studio that the .cproject file can be modified even when 
the settings for the project were not changed.  This can be seen by entering the 
settings dialog and clicking apply directly after project creation. 
 
In addition there are issues in generic Eclipse in this area. 
 
For option comparison, comparing the makefile is the easiest way to ensure the 
project settings are identical. 

4640 Application When a program is compiled by inter-module optimization with the CCRX 
toolchain, the disassembly view cannot always display the disassembly 
instructions mixed with source code. 

4665 Profile plugin 
When a single address is specified as the filter for the profile plugin it does not 
work correctly.  The addresses matching the filter are not displayed in the view. 
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4698 GDB 

A symbol address is not changed correctly at registering an Event Point for "Trace 
Start" and "Trace Stop" eventpoints with RL78. 
 
The right address is displayed in the Select Symbol dialog. 
 
However it is changed into the wrong value when shown in the Eventpoints view. 

4813 HEW Project Converter The simultaneous build setting is not setup when the project is imported from 
HEW.  Please visit the C/C++ Build preferences and select the Behavior tab. 

4825 CCRX Build plugin "Build selected file" does not work correctly when the assembler source file is 
selected. 

4939 Trace plugin 
In the Trace Acquisition dialog for the Renesas RX simulator, 
 
The Trace Output field is not necessary.  It cannot be modified. 

4940 Application 

An "Exception occurred during launch" message is displayed  
 
approximately 30 seconds after connecting to a target when using Hot Plug and 
using an image file. 

4948 Application 

When source file is modified while debugging and the module rebuilt is 
downloaded via the 'module has changed' dialog. 
 
The module downloads correctly, the target is reset, but the e2 studio user 
interface does not show that PC has changed until a step is done. 

4972 Application 
Parallel build is not enabled after conversion from CCRX project to GNURX 
project. 
 
This can be switched on in the build configuration after conversion. 

5014 Application CCRX to GNURX conversion: Custom tool added in CCRX project is not available 
in the converted GNURX project. 

5054 Application CCRX to GNURX Project Conversion: .mot file is not generated while building 
release configuration for the converted project 

5058 Application Section name ending with * is not mapped after conversion. 

5060 Application Optimization options are not mapped as expected when options are set on single 
file. 

5100 GDB 

If uint32_t is used as variable type for bit-field members, the values for the 
variables cannot be displayed in expressions windows ind GDB. 
 
unsigned long, unsigned int and uint16_t work fine.  This can be observed when 
using CCRX. 

5190 Coverage plugin Address Range Coverage for IECUBE does not correctly display coverage where 
the address range contains any region which contain non-code data or code which 
does not have a line number. 

5200 Coverage plugin When enabling coverage support for a file that should have been executed in the 
last debug operation it shows all source lines as not covered.  When another 
debug operation such as a step takes place the file then shows coverage results. 
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5202 Debug Console plugin 

Changing text encoding into a non UTF-8 setting, such as Shift-JIS also changes 
the setting for the debug console. 

 
To stop this happening you can modify the setting for "Encoding" to not inherit on 
the debug configuration, common tab. 

5216 Application 
The KPIT RZ GCC toolchain is no longer supported within e2 studio.  Instead you 
must download the new KPIT ARM-none-eabi GCC toolchain which is available 
from the KPIT website. 
 
The KPIT ARM-none-eabi 14.01 release is exactly the same as the KPIT RZ 14.01 
release but with a different name.  This is the only difference. 

5244 Application When using the RX Simulator in some cases the program can stop at a breakpoint 
which was already removed. 

5266 CubeSuite+ importer/exporter When importing a CubeSuite+ project a build error occurs in some cases.  This 
was due to the %ProjectDir% which is a placeholder for CS+ which should be 
converted as ${ProjDirPath?}. This was not happening correctly. 

5267 CubeSuite+ importer/exporter When a RX64M project is imported the "-rx-force-v2" option for gdb was missing.  
This option needs to be specified for successful RX64M connection. 

5271 Application As now -mcpu=rx100 option is supported by GNURX toolchain from v13.01 
onwards, e2 studio should handle the cpu command based on CPU selection and 
toolchain version. 

5272 Application The RL78 GCC Linker section displays the same address for stack and data 
section only for debug configuration 

5273 Application The edit eventpoint dialog for a 'data access' type shows address conditions, 
'address mask' and 'end address' when using the RL78.  These are not supported 
for this debugger so should be disabled. 

5274 Application 

To see saved trace file, users have to do two steps:  
 
First they need to "Load trace file" and then check "View Saved Trace".  The 
second step should not be necessary. 

5277 Application In certain situations when using CCRX there were problems displaying local 
variables. 

5280 RL78 GCC build plugin 
There are Non-G13 devices (except G10, G14, F13&14) which have external 
multiplier capability with -mmul=g13 option. 
 
Therefore this option needs to be made available for more devices. 

5324 Memory Usage plugin The memory usage view fails to read the map file correctly to determine memory 
usage when the map file contains some sections that not belong to the RAM and 
ROM area. 

5326 CCRX Build plugin When importing a CCRX project from HEW to e2 studio some the -nostuff option is 
not converted correctly.  

5349 Coverage plugin In the coverage view variable type information and the related data is not listed 
correctly for each variable. 
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5350 CDT RL78 Unable to view IO Registers in Memory View.  Adding a memory monitor at 
address 0xFFF00 (start of IO Register area) shows a message stating that only 
memory addresses from 0x0000 to 0xFFFF can be viewed. 

5362 HEW Project Converter 

There are issues with HEW project conversion for the CCRX toolchain.  Some 
options were not converted correctly. 

e.g. 
-lang=ec++ 
 
When a C++ source file does not exist in a project, its option is deleted. 
 
When a C++ source file exists in a project, its option is converted as individual 
option of C++ source file but the option is not output while building. 
 
-nostuff 
 
It is deleted, without being converted. 
 
-section=C=CE 
 
It is deleted, without being converted. 
 
-nostuff=C,B 
 
It is deleted, without being converted. 
 
-case=ifthen 
 
It is deleted, without being converted. 
 
-obj=prep -noline 
 
It is converted correctly but the option is not output during building. 
 
-save_acc (Library Generator) 
 
It is deleted, without being converted. 
 
-pack (Library Generator) 
 
It is converted correctly but the option is not output during building. 
 
-show=all (Linker) 
 
It is deleted, without being converted. 

5387 Trace plugin In some cases saving large amounts of trace data to file using the E20 can fail.  In 
some cases (~500k records) an exception occurs and save fails.  

5396 Application When opening a new editor from "New editor" of "Window" menu, the editor 
always enable folding after restarting e2 studio.  This is even the case when the 
user has disabled folding for a new editor in the Editor preferences. 

5430 Application e2 studio should be updated to use the latest GDB.  This means that symbol 
information modified by a reload operation would be reflected within the e2 studio 
environment. 

5440 Application The Profile view is not updated following the first load of debugger.  Subsequent 
load operations show data as expected. 

5451 Profile plugin 
In some cases the coding assistance "format" function removes source code lines 
that should not be removed. 
 
This was noted in a file that has two #defines separated by a single blank line. 
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5461 Application 
When using multiple download modules, if any one of the download module 
operation fails the connection operation is halted.   
 
Users would expect an error message for the sub-modules rather than an aborted 
debugger connection. 

5496 Application 
When creating a RL78 project and launching the RL78 GDB simulator the launch 
fails.  This is because the debugger support is not extracted until a hardware 
debug session is launched. 
 
To work around this launch a hardware debug configuration.  No hardware is 
required to just extract the files. 

5545 Application Once filtering for trace is set, it remains set in the debugger even if the trace 
feature is disabled - but cleared from the filter dialog box. 

5570 Application 
When using the headless build function of Eclipse, e2 studio uses the wrong build 
configuration even when the configuration is specified on the command line. 

5591 GDB In case of KPIT GNUSH-ELF v13.01 Toolchain '''-fomit-frame-pointer''' must be 
added, Settings->Compiler->Other->User defined options, in order to able to 
debug the project properly.  
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8. Known open issues in 3.1.1 

ID Component Description 

17 IO view plugin 

There are some IO Registers where the same memory address holds 2 registers with difference 
access sizes. These registers are general a read-only register and another register used for writing 
which is write-only. 
 
These registers are currently all listed as R/W in the IO Map file and so the view will attempt to 
display values for the wrote-only registers. When it does this the bytes are displayed reversed. 
 

220 GDB server 

e2-server-gdb executable currently causes a security alert in Windows when executed for the first 
time.  The publisher is currently undefined also.  Accepting the dialog allows normal operation to 
proceed. 
 

364 Application 

 
In case of MinGW toolchain projects - Whenever you add any include path in the compiler / 
assembler include path option, it is displayed in the Project Explorer -> <prj_name> -> Includes. 
 
In case of KPIT / Renesas toolchain projects - Whenever you add any include path in compiler / 
assembler include path option, it is not displayed in the Project Explorer -> <prj_name> -> Includes.  
 
It only displays the default include paths added during project generation.  The include paths are 
shown in the build option preferences as you would expect. 
 

803 GDB server RL78 program execution stopping on 'Equal' when 'Not Equal' is specified in the Compare Settings. 
 

873 
Debug 

Configuration 

No Renesas GDB hardware launch shortcut for IAR & Green Hills plugins.  Launch shortcut needs 
manual creation. 
 

874 Event points 
plugin 

Execution Address Eventpoints with trigger count do not work with Breakpoints on Segger RX. 
 
Setting an execution address eventpoint with a trigger count on Segger JLink RX62N is not possible 
if any breakpoints exist, including the default at main. 
 
If an execution address eventpoint with a trigger count is set with a breakpoint both the eventpoint & 
the breakpoint do not function. Multiple breakpoints are set then only 1 does not work. Additional 
eventpoints function as normal. 
 

935 GDB server 
RL78 G14-2 only allows one Event Break eventpoint 
 

1263 Application 

RX200 CPU selection should not be supported for toolchains =< 1.00.01 for the CCRX Renesas 
toolchain. 
 
This toolchain does not support RX200. 
 

1460 
CCRX Build 

plugin 
Project builds, but rx_convertor.exe fails when on network drive. 
 

1486 Application 
Breakpoint properties do not work when set in the CDT dialogs.  For example using the filter 
operation and removing the breakpoint for the process being debugged. 
 

1595 Application 
Renaming a project using the right click menu in the project explorer causes its respective debug 
configuration to disappear. 
 

1616 
RX GCC build 

plugin 

The options of a Build Configuration were not correct after specifying Multiple Configurations... 
functionality. 
 

1640 Application 
After creation a project cannot be deleted straight away.  If the user waits around 30 seconds the 
project can then be deleted. 
 

1778 Application 

When setting the 'Internal Flash Memory Overwrite' debug option, it is possible to exceed the 
maximum number of non-continuous memory blocks supported. No warning is given if this limit is 
exceeded. 
 
When setting this option ensure the limit (16 for RX devices) is not exceeded. 
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1808 
HEW Project 

Converter 

Import a HEW RX project in e2studio using the HEW project importer. 
 
Check: Project > Properties > Compiler > Source > Include file directories.  Paths are duplicated 
 

1859 GDB server Program execution stops inside a range when Range Exclusive is specified in the address settings 
for OA event points. 

1889 Application 

Due to file extension issue with .s and .S and due to known bug, e2studio users will not be able to 
use .s or .S effectively to pre-process assembly files that need GCC. Hence we  suggest renaming 
these files to use: 
 
.S -> .asm 
.s -> .src 
 

1936 Coverage plugin When using the IECUBE for RL78 the source lines for coverage are not being highlighted correctly in 
some cases. 

1950 HEW Project 
Converter 

A user tries to import an already imported project (in a different workspace) again. However the 
project is deleted from the previous workspace. 
 
This results in the following error message "The selected .hwp file overlaps the location of another 
project". See attached dialog. 
 
This is because when the project is removed from the project tree the Eclipse projects are not 
physically removed.  Deleting the Eclipse project files from the directory allows the operation to 
continue. 

 

2010 HEW Project 
Converter 

HEW Project Import fails to build file due to File or path name too long. 
 
This is due to the difference between HEW and Eclipse.  In HEW object files are output to the 
configuration directory.  In Eclipse the files are output alongside the source file in the same directory. 
 

2081 Application 
After building a project if user changes anything in linker subcommand file option, only ObjCopy is 
gets invoked. Linker should get invoked. 
 

2161 Application 

Software breakpoints are not supported on targets that use external flash to run application. 
 
Also, in this case 'force Hardware Breakpoints'(In Debug tool settings) set to 'No' by default. 
 
A warning message should be displayed while trying to set software breakpoints in such cases.  
 

2193 GDB Server SH Reload of code for SH devices with external flash does not work. Instead, disconnect and reconnect. 
 

2299 
RX GCC build 

plugin 

It is possible for .c and .C files to be treated in the same manner in certain situations which is not 
correct. 
 
(.C extension is changed to .c during project build). 
 

2416 
Project 

Generation 

Use of duplicate register is allowed for RXC project generation. 
 
 1. Create RXC project 
 
 2. Go to RXC Global option page, select "ROM" -> "R8" 
 
 3. Select the same value for any other register (e.g. "RAM" -> "R8"), it gives error message and 
prevents the user from project creation. 
 
 4. Now select "R8" again for "RAM" register. It doesn't show any error message and allows user to 
create the project. 
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2486 Profile plugin Acquiring profile results can take a very long time following RX Simulator debugging. 
 

2651 Application 
Library Template: Build fails when spaces are present for file or folder name. 
 

2657 Application 
When importing a configuration from another project when building a "File not found" exception is 
shown when the user tries to import external linker file. 
 
Creating the file inside the project directory should solve this issue. 
 

2667 GDB 
When using a big endian target, areas of memory not covered by the download module are 
considered little endian.  This causes problems when viewing disassembly and memory. 
 

2693 Application 
HEW Importer, output file(.P/.PP) is not generated while building the project. 
 
Workaround: User will need to select Settings -> Compiler -> Object -> output file type -> Pre-
processed source file -> OK after importing the project and then build the project. 
 

2762 Application 
When using assembly code within a C source file, Codan errors can be observed in the editor.  Even 
though the project builds successfully. 
 

2859 IAR plugins 
When using IAR projects the SFR names (e.g. PIOR1_bit.no1) are not understood correctly in the 
editor. 
 

3039 Application 
When exporting a project that has external linked folders rather than files which are resident in a 
source directory they lose their directory structure in the exported archive.  When importing back into 
e2 studio the files specified as the original relative path are then not found.  This is a standard 
Eclipse issue and is the current specification. 
 

3054 Application 
Real-time refresh will not update visually for a complete structure. 
 
The workaround is to monitor individual members of the structure. 
 

3389 Application 
When debugging files with the same name show source addresses even though it may not be 
correct for the file in question.  The full file path is not considered just the filename and current debug 
context.  This can lead to e2 studio showing addresses unnecessarily. 
 

3412 Application 
'Execute The User Program After Ending The Debugger' should not be enabled when the target is 
powered internally. 
 
This can cause the debugger to hang. 
 

3526 Application 
In some cases when using RX with the CCRX compiler the profile view does not display the source 
file name and path in the window. 
 

3550 Application 
Custom placeholders are not expanded when importing a project from HEW.  This is currently 
expected behaviour but may be improved in a future version. 
 

3663 Application 

With 2 targets connected, clicking between the two debug contexts in the Debug View will update 
the source addresses in the open Editor files. 
 
However changing debug context does not seem to get detected if clicking on the top-level of the 
debug context rather than on the lower level.  
 

3804 Application 

The code generator is not automatically registered when installing into generic Eclipse.  Browse to 
the CG plugin and then run the batch files that reside in the tools directory. 
 
e.g.  
 
C:\Renesas\e2_studio\eclipse\plugins\com.renesas.cg_1.0.0.201309061659\CodeGenerator\Tools 
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3836 Application 
Dependencies with file name that have spaces may cause dependency scanning issues.  Where 
possible it is better to avoid using spaces in dependency file names. 
 

3847 Application 
When using the display as array feature in the expressions window it appears that data can be 
skipped and is not updated. 
 

3928 
CCRX Build 

plugin 

By default the e2 studio editor character code is set to UTF-8.  This means it is possible to enter 
characters that are then not supported by default by the CCRX toolchain. 
 
CCRX default input is SJIS. 
 
To enable UTF-8 for the toolchain you must first select C99 support. 

3945 Application 

When importing a HEW project if it contains folders with the same name at the same hierarchy then 
not all the files will import successfully.   
 
i.e.  
 
"....\WorkSpace\WorkSpace\Developments\src\embOS\Util\MEASUREMENT.c" 
 
"....\WorkSpace\WorkSpace\Developments\src\protocols\util\SerialUtil.c" 

3950 Application 
Breakpoints cannot be unset within the editor when code is #ifdef out. 
 
These breakpoints will need to be removed from the breakpoints plugin. 
 

3992 Application 
When importing projects from HEW into e2 studio when the files are read only, build errors occur 
following import.  Ensure the files are writable. 
 

4104 Application 
When the project is re-named.  If the user then uses the feature project > Build Configurations > 
Build All.  The active configuration builds successfully but subsequent configurations fail. 
 

4105 Application When using GCC on Japanese Windows.  If you create a new workspace on the desktop the default 
GCC projects fail to build correctly. 

4129 Project 
Generation 

FPU option is not set correctly for GNURX (RX200/RX100) executable project.  "Disable generation 
of RX hardware FPU instructions" option should be checked and greyed out for RX200 and RX100. 
However this option is not checked and is not greyed out. 
 

4189 Project 
Generation 

It is not possible to build project which has more than 98 characters in its project name. 
 

4191 GDB server RX 

When using Segger JLink, with the "Force Hardware Breakpoints" debug option enabled, adding 
more than the maximum amount of breakpoints for a device and then removing some can lead to 
none of the breakpoints firing. Workaround is to add a single breakpoint back in to trigger the reapply 
of all others. 
 

4213 RX GCC build 
plugin 

It is not permitted to use the tool chain editor on the Settings pages to attempt a conversion from 
GCC to CCRX or CCRX to GCC.  This conversion is not permitted and may stop your project 
working correctly. 
 

4303 RL78 GCC build 
plugin 

When the project has a toolchain that does not match the path for the toolchain installed on the 
machine problems with build can occur. 
 
Workaround is to delete the 'org.eclipse.cdt.core.prefs' file from .settings folder and then import the 
project. 
 
Alternatively you can modify the toolchain path from Properties > C/C++ Build > Environment. 
Modifying the toolchain path builds the project successfully. 
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4350 CubeSuite+ 
importer/exporter 

When importing a project from CubeSuite+ to e2 studio the “toolchain version is changed" dialog is 
always displayed. 
 
This is because the version string in imported project file and the toolchain information in e2 studio 
does not match.  Ignoring this dialog and continuing should result in a successful import. 
 

4422 Application 
When debugging a project that has been imported but that has not been rebuilt you need to setup 
the debugger to look in the original source file location. 
 
This is done via the Source tab of the Debug Configurations dialog.  
 

4450 CCRX Build 
plugin 

Linker section settings of Renesas toolchain are not getting saved for multiple configurations. 
 

4515 
CCRX Build 

plugin 

When building projects with CCRX that are in deep directory structures it is possible to experience 
build issues.  e2 studio is unable to build projects which create command lines greater than 8191 
characters. 
 

4579 RX GCC build 
plugin 

All configuration changes are not saved on changing multiple configuration settings in one session 
for GCC tools.  Specifically this is referring to multiple settings changes across multiple 
configurations and the clicking apply. 

4597 Application 
In some cases when a before PC eventpoint is set just after a break point, the program execution 
will not stop at the address the eventpoint is located at. 
 

4833 Application 
The clean functionality executes every time irrespective of whether the object file is present or not. 
 

4857 GDB 

GDB considers PUSHC instruction to be part of the function prologue and it skips it.  
 
Inserting a break point at *functionname 
 
instead of functionname solves the problem. (* tells GDB to start at the actual beginning of the 
function without skipping the prologue). 

4881 
CCRX Build 

plugin 

When using CCRX if there are certain characters in the build path such as $ in the workspace name 
it can cause the build to fail. 
 

4976 CCRX Build 
plugin 

When using the SHC compiler.  Selecting "Absolute (SYSROF)" in [Linker][Output][Type of output 
file] does not work correctly. 
 

5021 GDB 
When using the CCRX toolchain, variables placed at address 0x0000 are displayed as "no debug 
info" in GDB and variable type is lost.  
 
For variable type unsigned char (section B_1) and unsigned short (section B_2). 

5041 
CodeGenerator 

plugin 

Code Generator can delete user code between /* Start */ End comments in some situations. 
 
Using the code generator if the following code is placed in the main function:  
 
//if(data_in!=0xAA){  
 
on a line by itself, all of the main code will be removed when Generate Code button is pressed. 
 
The key issue is that the { brace is on the same line as the comment. 
 

5063 Application Dependency scanning is not working for assembler file. This is for GCC build plugins. 

5083 
CubeSuite+ 

importer/exporter Folder level build options are not converted correctly. 

5124 Application Active configuration lost while importing project (which is exported as file system). 
 

5171 CCRX Build 
plugin 

Files included in the Pre-include build options are not analyzed for the pre-processor statement in 
the editor.  This can give the impression that code is not included in the build when it is. 
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5179 CubeSuite+ 
importer/exporter 

When CubeSuite+ project imports to e2 studio, Build cannot perform sometimes. 
[Workaround] 
 
Please add the <root folder> to "C/C++ General -> Paths and Symbol -> Source Location" 

5201 Application 

If you create a project and debug session for a GDB simulator before executing a hardware debug 
session it will fail.  This is because the debugger support is not unpacked until a hardware debug 
session is used. 
 
To work around setup and launch a hardware debug session.  You do not actually need hardware to 
do this. 
 

5243 Application 
When using GCC build plugins there are some library generator options that are not restored when 
you select "Restore Defaults".  These are: 
 
 -falign-jumps, -funit-at-a-time, -ffunction-sections, -fdata-sections, -fno-function-cse 
 

5275 Application 
In some cases the project build fails for a custom configuration when it is created from a 'Default 
configuration'. Exceptions are often thrown due to missing linker section setup data for the new 
configuration. 
 

5290 Application 

When you add a new configuration, please do not specify 'Default Configuration' as a configuration 
used as a base. 
 
If you specify the 'Default Configuration', the configuration which does not operate correctly is 
created. 
 

5341 CCRX Build 
plugin 

'''Problem''' 
 
Project is cleaned incorrectly before running "Build Configurations > Build All" 
 
at 2nd time after "Build Configurations > Clean All" 
 
'''Workaround''' 
 
Build the Configurations individually. 
 

5348 
CCRX Build 

plugin 

'''Issue''' 
 
Could not add new section in case the list already contain any section was named 
NEW_SECTION_* (* is not number 1, 2, 3...) in CCRX project. 
 
'''Workaround''' 
 
Avoid naming new added section as NEW_SECTION_* (* is not number 1, 2, 3...) 
 

5372 Application 
If you use RX200 series E1/E20, and if you set Data as Trace Type in the Trace Acquisition dialog 
even once, Trace view does not show the branch trace information. To show the branch trace 
information, please disconnect debugger once and then connect again. 

5394 
CCRX Build 

plugin 

'''Problem''' 
 
If a source file folder (already included in C option) is deleted, its path was added to Assemble 
include. 
 
'''Workaround''' 
 
Remove the path in "Include file directories" will stop the warning. 
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5420 Application 

Renaming & Importing an existing project fails to find projects in the current workspace folder. 

 
The automatic project search filters out all existing projects located in the same directory as the 
chosen workspace. 
 

5456 IAR plugins 
In some situations e2 studio IAR projects are not imported correctly into later versions of the tools. 

5467 Application 
Settings in the 'Format' dialog (Memory view) are not restored. 
 

5471 
CCRX Build 

plugin 

Problem 
 
When the project is imported before CCRX project is created, "Cannot specify this option" may be 
displayed even if the relation between FPU and CPU is correct.  
 
'Workaround 
 
Please perform import of a project after creating a project once. 
 

5529 Application 

When building a RTOS project using the CCRX toolchain it can show many CODAN errors even if 
the include paths are set correctly. 
 
[Work around] 
 
Change the CODAN preferences. (Set "Symbol is not resolved" to be unchecked.)   
 

5539 Application To use trace record events for RH850 with E1 emulator, trace start events are required. 
 

5547 Application 
To use the data access events as trace start, trace stop or trace record for RH850 with E1 emulator, 
please do not use the "Compare Settings" condition for the event. 
 

5551 Application 
If the maximum number of break points are used for RX with E1/E20 emulator, the connection or the 
program execution may fail. In this case, please reduce the using break points. 
 

5569 
RX GCC build 

plugin GNU (RX) assembly list is not generated for the last compiled C source file in the build. The work 
around is to specify the options for this file specifically for the list file setting. 

5573 Waveform plugin 
More sample data than the user has requested is displayed on the waveform view after making the 
buffer size smaller than a previously larger buffer. 
 

5575 
CodeGenerator 

plugin 

The dialogue which confirms the save of a project of code generation isn't indicated. 
 
The condition is the case that e2studio opens debugging perspective and doesn't open a panel of 
code generator. 
 

5576 GDB 
For RH850 multicore devices, step return may cause the error. Please do not use step return 
execution. Instead, try 'finish' command in GDB console. 
 

5586 
CodeGenerator 

plugin 

When importing project which did an export by CS+ in e2 studio, the setting contents of code 
generator aren't reflected. 
 

5587 CodeGenerator 
plugin 

Even when the source code generated by a code generator became unnecessary by change in the 
setting of a code generator, source code will be while being made the build target. 
 
When source code became unnecessary, please open a property of source code and check 
"Exclude resource from build". 
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5592 CodeGenerator 
plugin 

RL78/L12 group of MCUs (RL78 family) 
 
1. 
 
The value of User option byte C1H is wrong when LVD is used as Interrupt mode. User option byte 
setting is generated in r_cg_vector_table.c. Please change the value of C1H to correct one.  
 
2.  
Detection level '3.98V' is missing as a choice at GUI when LVD is used as Interrupt mode and Reset 
mode. 
 

5598 
GDB server 

RL78 

When using RL78 104LE, display the PORT branch in the IO Registers window.  The values 
displayed for this registers does not correspond to the data in the memory view at the same location.  
 

5606 Static Analysis 
plugin 

Stack Analysis does not recognize "_PowerON_reset_PC" as "Global Function". So, user cannot 
jump from stack list to _PowerON_reset_PC. 
 
Workaround: comment out the following codes of "reset_program.c" and re-build. 
 
- #pragma entry PowerON_Reset_PC 
 

5622 Project 
Generation 

Regardless of using trusted memory, TMEF and TMINF register settings are necessary and should 
be pre-set before running RX64M device. 
 
The values are placed typically in vector table. See the device hardware manual for the details.  
 
If trusted memory is not used, 0xffffffff (==factory default) to be set for both TMEF and TMINF 
registers to avoid unexpected behaviour.  
 

5632 Multicore 
When using multicore projects the Debug View may show an incorrect name for the second loaded 
module (as a duplicate of the first) 
 

5636 Multicore 
When using multicore debugging with RH850.  When a reset operation takes place both cores are 
reset as you would expect.  However the second core status is not updated in the debug view.  
Further execution will refresh this information. 
 

5637 Multicore 
For RH850 multicore devices, disassembly result may be different from the expected. In this case, 
please refresh the view after changing the debug context to the other PE. 
 

5652 Application 
The debugger does not show the contents of float variables in a structure correctly when the 
compiler option "Pack structures" is used.  This is with the CCRX toolchain. 
 

5656 Multicore 
For RH850 multicore devices the connection process can stall if there are active breakpoints in the 
project. To remedy disable the breakpoints before connection and re-enable once connected.  
 

5665 CodeGenerator 
plugin 

The project kinds supported by Code Generator are below.  
 
- C project - Executable (Renesas) 
 
- C project - Executable (IAR) - Empty project 
 

5666 Application 
For RH850 multicore devices, trace view may not respond if the disassembly mode is selected. 
Please do not use disassembly mode in trace view. 
 

5668 Coverage plugin 
In some cases when using the Coverage facility with the RL78 IECUBE some lines are shown as 
'branch' or partial coverage when they should be 100% covered. 
 

5670 V850 GCC build 
plugin 

When rebuilding an RH850/F1H project there should not be an active debug session or a build using 
the GHS toolchain will fail. 
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5674 CCRX Build 
plugin 

'''Problem''' 
 
RTOS project is generated and build, CODAN error "Symbol xxx could not be resolved" is shown. 
 
'''Workaround''' 
 
Unchecked Preferences>Code Analysis>Syntax and Semantic Errors>Symbol is not resolved and 
disable CODAN settings. 
 

5693 GDB server RX 
The PSW register shown in the register window does not match the PSW value at reset as shown in 
the RX hardware manual.  
 

5705 
CCRX Build 

plugin 

'''Problem''' 
 
When the "Renesas Toolchain Settings" is opened from the Optimization Assistant and clicked the 
"Linker -> Section",null pointer exception occurs. 
 
'''Workaround''' 
 
Please select the project name and perform the right clicked menu "Renesas Tool Settings". 
 

5708 GDB server RX 
RX64M OFS1 setting: The voltage monitoring 0 reset function cannot be used. If OFS1 register is 
modified by downloading to enable the voltage monitoring 0 reset function the emulator will modify 
the register value to disable the voltage monitoring 0 reset function. 
 

 


